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QuickBooks 2006 has a new way of managing company data that may require some 
changes in the way you install and configure the software for network installations, 
compared to previous versions of QuickBooks. If you are not operating in a network 
environment, you do not need to worry about the new procedures. 
 
Users of QuickBooks Enterprise 6.0 should refer to guides specific to that product, such 
as the one at http://www.quickbooks.com/support/PDFs/Misc/qbe2006_mui.pdf. 
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Introduction 
 
Unlike the simple flat files of prior years, QuickBooks 2006 is built on top of a robust 
relational SQL database. This new structure has the potential to deliver significant 
improvements in performance and functionality. 
 

• A relational database is not a flat file that contains all the data that’s been entered 
into a file; instead, the data is organized in logical tables (mini-files within the 
main file) to make it easier and faster to find, link, and verify data. A relational 
database is easy to extend (grow), which means programmers can add new 
categories and types of information easily, and structure the new information in a 
logical manner in order to link related data properly. 

• SQL stands for Structured Query Language, indicating that the processes 
involved in accessing the data in the file are based on rules that enhance the 
efficiency of data retrieval while performing data entry and when creating reports.  

 
To make sure the new database performs as well as it’s designed to, you may have to take 
a few more steps when installing QuickBooks 2006 on a network than you did when 
installing previous versions of QuickBooks. 
 
The main focus of this document is for the majority of network installations for 
QuickBooks customers, where users access files over a Windows peer-to-peer network. 
The document also covers configuration requirements for client/server Windows 
networks (domains). 
 
Other types of network installations will be the subject of additional White Papers, as 
Intuit updates its Network/Multi-User Setup page. Information on obtaining these 
additional White Papers is available at the end of this document. 
 

Who Needs to Read this Document 
 
You should read this document if you are installing QuickBooks in an environment 
where company files are accessed across a network – regardless of whether those files  
are worked on by multiple users or a single user. Following are some examples of the 
environments that may be affected by the changes in installation procedures: 
 

• Your company files are on a computer running QuickBooks, which is used by a 
QuickBooks data entry person, and at least one other person, working from 
another computer, also works on those files. 

• Your company (commonly an accounting firm) has multiple computers running 
QuickBooks, and each computer contains QuickBooks company files that are 
worked on by the person who usually works at that computer. However, users on 
other computers occasionally have to access those files, and the person working at 
that computer occasionally has to access files stored on another user’s computer. 



• Your QuickBooks company files are on a computer that is acting as a data-only 
computer. Users access these files from other computers on the network. It is 
common for accounting firms to create a data-only computer to house client files 
that all staff members can access. However, some businesses create data-only 
computers to hold all data files from various software applications, in order to 
centralize data files and make backups more efficient. 

 

New Components in QuickBooks 2006 
 
Like previous versions of QuickBooks, QuickBooks 2006 contains two important 
elements: The software, and the data file(s) you use in the software. However, 
QuickBooks 2006 adds several components that are responsible for the fact that you have 
to think differently about the way you install and use the software: 
 

• The database 
• The database manager 
• The data file hosting service 

 

The QuickBooks Database 
 
The database is a component of the software, and is new in QuickBooks 2006. The 
database is the container for the company file(s) you create and maintain in QuickBooks. 
The database stores the data in a logical manner, checks the integrity of data entry, and 
provides data retrieval services when you need reports.  
 
The new database offers many significant advantages for QuickBooks. It helps manage 
the relationship between different types of data, and these management functions ensure 
that data that is referred to elsewhere in the database is not inadvertently lost. It makes 
sure that updates to a set of data happen as a complete “chunk” so that the whole chunk 
succeeds or fails. This is important because a partial save can corrupt records in the 
company file, or corrupt the entire data file. 
 
For example, consider a typical Invoice transaction. When you save the transaction, a 
significant number of records are affected. Items need to have their history updated, 
inventory items must have the on-hand quantity updated, a variety of accounts (accounts 
receivable, income, COGS, etc.) need to have balances updated, the customer’s balance 
and history must be updated, and so on. Using a true relational database ensures that if 
anything happens (network failure, disk failure, power failure, etc.), either the complete 
update happens or none of it happens. (Database terminology for this function is database 
transaction, not to be confused with an accounting transaction in QuickBooks.) 
 
Further, a true database maintains a transaction log that can be invaluable if you have any 
type of data disaster, recovering accounting data changes that were saved after your last 
backup. (If you’re currently using QuickBooks 2006 you may have already noticed the 
filenames with the extension .TLG that exist in the folder where your company file is 



located (e.g. MyCompanyName.TLG). That file is the database transaction log for the 
company file with the same name. 
 
Finally, a true database offers the potential (which QuickBooks has only begun to 
scratch) for dramatic performance improvements, especially when there are a large 
number of accounting transactions or when the relationships between data are important 
(such as in Reports, or in the Customer Center when displaying all the transactions for the 
Customer selected in the center). 
 

Why Can’t QuickBooks 2006 Files Be Used across a Network the 
Same Way as Other Files? 
 
To deliver the advantages discussed in the previous sections, database servers interact 
with the database file(s) in a manner that differs greatly from the way other applications 
(for example, earlier versions of QuickBooks, word processors, and spreadsheet software, 
etc.) interact with their data files. This means that a database server requires a higher 
degree of reliability and performance when accessing the database file. 
 
In particular, the database server requires very low latency (the time between asking for 
data from a particular place in the file and when that data begins to arrive, which some 
users refer to as speed, or performance). While the performance of networks has 
improved dramatically over the years, network latency is affected by other things 
happening on the network, making it unpredictable. The low-latency connections 
required by a database server cannot be relied upon over a file-sharing network. So, while 
installing QuickBooks 2006 in the Alternate Configuration Mode may appear to work, 
users will definitely experience poor performance. More important, a variety of 
connection errors can occur at seemingly random intervals. For example, a connection 
error can occur if the user (or even some other user on the network) is downloading a 
particularly large file attachment in their e-mail, causing the network’s latency to  
exceed the requirements of the database. 
 

The QuickBooks Database Manager 
 
The database manager is a software component that manages the database to make sure 
that data meets certain conditions before it is written and saved. This software also 
manages users who are working in a company file from another computer on the 
network. When remote users access a data file, they are actually “talking” to the database 
manager, which then “talks” to the data file. 
 

The Data File Hosting Service 
 
This is not a software component, it’s a service that is performed by the QuickBooks 
software. Because of the database manager, every data file that is used in QuickBooks 



2006 has to be “hosted”. The host’s job is to permit access to the file, and data files must 
be connected to the hosting service in order to open and use those files. 
 

Configuring QuickBooks 2006 for Success 
 
For best results, Intuit recommends that QuickBooks 2006 be installed on any computer 
that contains QuickBooks 2006 data files. Intuit calls this the Recommended Multi-User 
Setup Mode. 
 
However, that technical name for this installation mode can be misleading, because the 
recommended mode is really only an issue for multi-computer scenarios (networks), not 
necessarily multi-user scenarios. Although most networks have multiple QuickBooks 
users, many businesses have multiple users working on their QuickBooks company file, 
but the file is on one computer shared by those users. If you don’t use multiple networked 
computers to work in QuickBooks, you don’t have to worry about the new installation 
procedures, no matter how many users work on your company file on a single computer. 
 
Because the recommended installation mode is that QuickBooks 2006 and its database 
manager be installed on any computer that contains QuickBooks 2006 data files, this 
means that QuickBooks data files are running in a Windows environment. A side effect 
of this requirement is that if you are running a Novell Netware or Linux/Samba data file 
server, it’s not going to work properly as a QuickBooks file server because you need 
Windows to install and configure the database. 
 
QuickBooks may appear to work with a company file on a data file server where 
QuickBooks is not installed; however that scenario usually impacts performance, and 
frequently results in lost connections between the client running the software and data file 
on the server. A lost connection while performing data entry can damage data files. 
Therefore, this is not the mode that will guarantee the best performance and reliability of 
QuickBooks 2006. We call this alternate or non-recommended mode, and it should be 
assiduously avoided. 
 
At this writing Intuit is looking into the possibility of addressing other operating systems 
in a future release. For now, your best solution is to provide a Windows-based system as 
your QuickBooks 2006 data server. If that’s not possible, see the information at the end 
of this document about obtaining the White Paper on running QuickBooks 2006 in 
Alternate mode. 
 
To make sure your QuickBooks system runs efficiently and accurately, you must install 
QuickBooks 2006 on every computer on the network that is involved with QuickBooks, 
which includes the following: 
 

• Every computer that holds QuickBooks 2006 files, whether or not a data entry 
person uses the computer to work in data files. 

• Every computer that is used by a QuickBooks data entry person, whether or not 
the computer holds data files.  

 



Accounting firms that support QuickBooks clients should install QuickBooks 2006 in its 
own folder on every computer, to make sure the installation process doesn’t replace the 
previous version of QuickBooks. This ensures you can continue to support clients who 
are using earlier versions of QuickBooks. 
 
In addition, accounting firms should be sure to create a specific folder for QuickBooks 
2006 data files, whether the files are stored on a central computer designated as the data 
file computer, or stored on individual users’ computers. Keeping all versions of client 
files in a single data folder increases the risk that you will open a client file in a version 
of QuickBooks later than that used by the client. Once updated to a newer version, the 
file cannot be used back at the client site until the client installs QuickBooks 2006. 
 
Most accounting firms use a data file folder named for the version of QuickBooks used 
by the files in that folder, e.g. QB2006Files, QB2005Files, and so on. In each folder, you 
can either store all the client files for that version, or create a subfolder for each client and 
store that client’s files in its own folder. The latter scenario works best because often the 
client’s QuickBooks data filename is not the same as the name by which the client is 
known to the accounting firm. For example, your client Smith, Inc. may have a 
QuickBooks data file named for the d/b/a name, such as SIWidgetsCo. In addition, you 
can use the client folder to store QuickBooks data file backups, spreadsheets, and other 
documents sent to you by the client, or sent by you to the client. 
 

Installing QuickBooks on the Computers that Hold Files 
 
When you install QuickBooks 2006 on a computer that holds QuickBooks 2006 data 
files, you have six steps to perform: 
 

1. Create a data folder for company files. 
2. Share the data folder. 
3. Make sure users can open files in the data folder (see the section “Remote User 

Access”). 
4. Install QuickBooks 2006. 
5. Configure QuickBooks to host files and enable the database server. 
6. Verify that the database service is running. 

 
You need to perform these steps on every computer that holds QuickBooks 2006 data 
files that are accessed by users at other computers. If you have one computer operating as 
a centralized data-only computer, you only have to do this once. If you have multiple 
computers that hold QuickBooks 2006 data files that are accessed across the network 
(common in accounting firms), you must perform these steps on every one of those 
computers. 
 
It’s best to install QuickBooks first on the computers that contain data files. That way, 
you can set up and configure QuickBooks so that when users working at QuickBooks 
software-only computers want to open a file, the files are ready for them. 
 



Remote User Access 
 
Starting with the R3 Update, QuickBooks created more stringent rules for permitting 
users on remote computers to open 2006 data files. You have two ways to set up 
QuickBooks so that remote users can work with the data files across the network: 
 

• Open each file once on the server (which can be automated with a utility you can 
download from QuickBooks). 

• Create a local user account on the server for every user that runs QuickBooks 
from a remote computer on the network. 

 

Opening Each File Once on the Server 
 
When you open a file once on the data file computer, QuickBooks automatically creates a 
companion file in the same folder where the data file resides. The companion file has the 
same name as the data file, but ends in the extension .ND. The presence of this ND file 
(which contains information the QuickBooks database needs about the location of the 
file), automatically lets any remote user open the data file. 
 
Because this means that each time you add a file to the data file computer you must open 
QuickBooks on the computer holding the data files, even if no user normally opens 
QuickBooks on that computer, QuickBooks has created a small utility program (called 
the File Scanning Utility) that will create the .ND files without the need to open 
QuickBooks on the data computer and open each file one at a time. 
 

Creating Local User Accounts for Every Remote User on the Network 
 
The user running QuickBooks on a network computer must have Power User or 
Administrator rights to launch QuickBooks. Starting with the R3 Update of QuickBooks 
2006, the same user must also exist on the computer that holds the data files, with the 
same permission level (unless you’ve already opened the company files once on the data 
server). 
 

• The user name must be unique to the data file server computer. If you are 
running a Windows domain that’s not a problem, because all user names must be 
unique. However, if you are running a Windows workgroup (a peer to peer 
network), it’s possible that two users on separate computers are logging into their 
own computers with the same user name. For example, you may have a user 
named Bob on one computer, and a user named Bob on another computer. You 
can only add one Bob to the data file server (you cannot have duplicate names on 
any computer), so you must have one of the users named Bob change his login 
name on his own computer. 

• The user name must have a password, and it must be the same on both 
computers. Many companies don’t use passwords for logins, because computers 
are assigned to a particular person, and no other user works on that computer. 



This isn’t a good idea in terms of computer security, but it’s a common habit in 
companies running Windows workgroups.  

 
If you have a QuickBooks user logging in to his computer without a password, you must 
add a password to the user account on his computer, and then use that password when 
you set up the user account on the data file computer. 
 
If you have many users accessing the computers that have QuickBooks 2006 data files 
from remote computers, it’s probably easier to open the files once on the data server 
instead (or use the QuickBooks File Scanning Utility to create the needed files on that 
computer). 
 
If you are running QuickBooks in a Windows domain, and you installed QuickBooks and 
the data files on the Domain Controller, you cannot set up local users. You can move 
the QuickBooks data files to another computer (recommended because domain 
controllers should not be used for anything except implementing basic domain functions), 
or omit the step of creating local users and open every file once (or use the QuickBooks 
File Scanning Utility). 
 

Creating Local Users 
 
If you choose to create local users, take the following steps: 
 

1. Right-click the My Computer icon, and choose Manage. 
2. In the Computer Management console, expand the System Tools icon in the left 

pane by clicking the plus sign. 
3. Expand the Local Users and Groups icon in the left pane by clicking the plus 

sign. 
4. Right-click the Users folder in the left pane, and select New User to open the 

New User dialog. 
 
Use the following guidelines to fill in the New User dialog: 
 

• In the User Name field, enter the user’s login name, matching the user’s login on 
his or her own computer. 

• Enter the password the user enters on his or her own computer (you must enter it 
twice). 

• The Full Name and Description fields are not required, but you can optionally 
enter any text you wish to. 

• By default, Windows selects the option User Must Change Password at Next 
Logon. Because you’ve entered the password this user is familiar with, deselect 
that option and select the option Password Never Expires. Click Create to save 
the new user, and make sure the name appears in the right pane of the Users 
folder in the Computer Management window. 

 



Putting New Users in the Appropriate Group 
 
Double-click the user’s listing in the right pane of the Computer Management window, 
which opens the user’s Properties dialog. Click the Member Of tab, which displays the 
group named Users as the user’s entire membership list. You must add this user to the 
Power Users group. 
 

1. Click Add to display the Select Groups dialog. 
2. Click Advanced to open the Select Groups advanced Properties dialog. 
3. Instead of going through all of the steps for setting search options, click Find 

Now to display a list of the groups for this computer. 
4. Select Power Users and click OK, then click OK again to add the group to this 

user's group membership list. 
 
Repeat these steps for each user who will access files on this computer. 
 

Creating the Data Folder 
 
By default, QuickBooks assumes data is stored in the same folder as the software, but in a 
network environment creating a separate folder makes it easier for remote users to find 
files, and also makes it easier to back up data files. 
 
Some businesses create a data folder as a subfolder in the folder holding their 
QuickBooks software; and other businesses create a separate folder for data on the hard 
drive. Accounting firms usually create a data folder on the hard drive, totally unrelated to 
the QuickBooks software folder. 
 
To create a folder, open My Computer and move to the location where you want to 
place the new folder: 
 

• If the new folder is going to be on a hard drive (the common scenario), open the 
drive by double-clicking its icon. 

• If the new folder is going to be a subfolder of an existing folder, double-click the 
drive icon, and then double-click the icon for that folder. 

 
(If you click the Folders icon on the My Computer window, you can move through the 
computer’s folders in the left pane, instead of double-clicking icons.) 
 
Choose File > New > Folder and give the new folder an appropriate name (e.g. 
QB2006DataFiles). Your new folder is ready to share and configure. 
 

Sharing the Data Folder and Setting Permissions 
 
Sharing a folder in Windows means configuring the folder and its files so that network 
users can access the folders in those files. For computers running Windows XP, the way 



you accomplish this task depends on the type of network you’re running: a workgroup 
(peer to peer network) or a domain. 
 

Sharing Folders in Windows XP in Workgroups 
 
If your network is operating in a workgroup, you need to change the way security is 
applied on the Windows XP computers that hold QuickBooks 2006 data files. By default, 
Windows XP uses a file sharing method called Simple File Sharing in workgroups (not 
in Domains). You can use Simple File Sharing to configure permissions on shared 
folders, but you cannot set permissions on the folder itself. (A folder that’s been shared 
has an identity on the network called a share, and also continues to have an identity for 
the actual folder.) 
 
WARNING on WINDOWS XP HOME EDITION: You can only disable Simple File 
Sharing on a computer running Windows XP Pro; not on a computer running Windows 
XP Home Edition. Therefore, you cannot use a computer running Windows XP Home 
Edition to hold data files that other users access from other network computers (but you 
can use Windows XP Home Edition to run QuickBooks and access files on another 
computer). 
 
To permit access to QuickBooks 2006 files, QuickBooks requires configuration changes 
to both the share and the actual folder. You must disable Simple File Sharing on every 
Windows XP computer that holds QuickBooks 2006 files, using the following steps: 
 

1. Open My Computer. 
2. Choose Tools > Folder Options. 
3. Click the View Tab. 
4. In the Advanced Settings box, scroll to the bottom of the list to find the setting 

named Use Simple File Sharing (Recommended). 
5. Click the check box to remove the check mark and disable Simple File Sharing. 
6. Click OK to return to the My Computer window. 

 
Now you can proceed to the task of creating a share and setting permissions on the share, 
and on the folder itself. 
 

Creating a Share 
 
Creating a share works the same in Windows 2000, Windows 2003 Server, and Windows 
XP Pro. To create a share, right-click the folder you created to hold data and choose 
Sharing and Security from the right-click menu. Then move to the tab labeled Sharing. 
Select the option labeled Share This Folder. Windows automatically inserts the Folder 
name in the Share Name text box. You can change the sharename if the folder name 
doesn’t clearly indicate the contents of this folder. Optionally, enter a description of this 
share in the Comments text box. (Note: The description text appears when remote users 
open My Network Places with the View set to Details.) You don’t have to change (or 



worry about) the other options on the dialog; the share is now created, and you can move 
to the task of setting permissions for remote users. 
 

Setting Share Permissions 
 
Click the Permissions button to open the share’s Permissions dialog. If you haven’t 
created users on this computer to match the users on all the computers that access these 
files, select the EVERYONE group, and then select the Full Control option. This is the 
fastest and easiest way to make sure everyone who works with the QuickBooks data files 
can save the data they enter in the files. 
 
If you’ve created local users for all the remote users who access the files in this folder, 
click the Add button and follow the prompts to assign Full Control to the Power User 
group, the Administrator group, or both (depending on which groups you used for the 
local users you created). You can alternatively enter the specific user names you created 
for those QuickBooks users. 
 
Click OK to return to the folder’s Properties Dialog. 
 

Setting Folder Permissions 
 
In addition to setting permissions for the share, starting with QuickBooks 2006 R3 you 
must also set permissions for the folder itself. To do this, click the Security tab in the 
folder’s Properties dialog. 
 
Use the same process described in the previous section for setting share permissions to 
give Full Control to the EVERYONE group (if you didn’t add local users to this 
computer), or the Power User or Administrator group, or to individual users. 
 

Installing the Software on a Computer that Holds Data 
Files 
 
After you start the QuickBooks installation process (by inserting the CD), you see a 
series of dialogs, most of which are self-explanatory and easy to follow. 
 
If this is your first installation of QuickBooks, the install process offers to install 
QuickBooks in a subfolder in your Program Files folder. You can change that 
installation location by entering a different location such as C:\QuickBooks (you do not 
have to create the folder first; QuickBooks will create it for you). 
 
If you already have a version of QuickBooks installed on the computer, the installation 
program will find it and use that location as the target folder for QuickBooks 2006. 
 



• If you are a business that is updating to QuickBooks 2006, accept that folder and 
QuickBooks will replace your older version. 

• If you are an accounting firm, you should enter a new location (for example, 
C:\QB2006) so you don’t overwrite your previous versions of QuickBooks 
(which you need in order to support clients on those versions). 

 

Enabling the Database Manager 
 
If you purchased a multi-user product (i.e. QuickBooks Enterprise 10-seat license or a 
Pro or Premier 5-Pack), you see dialogs asking whether you intend to host company files 
on this machine. If you answer yes, and the software you purchased is running R3 or 
higher, QuickBooks will proceed with installing the database server and launching it, so 
there’s nothing further you need to do. Hereafter, the database server starts automatically 
when you start the computer. If you’re using software CDs that are earlier than R3, you 
have to install the database server from within QuickBooks. 
 
If you don’t see dialogs during installation that ask whether you intend to host company 
files, or you didn’t select Yes, you merely need to install the database manually, within 
QuickBooks. Open QuickBooks, and choose File >Utilities > Host Multi-User Access. 
(You do not have to open a company file to use this menu command.) Follow the 
prompts in any ensuing dialogs that appear, to confirm your action. 
 

• If this computer is a data file-only server, and no user works in QuickBooks from 
the computer, you can close QuickBooks. As long as the computer is running, the 
database manager is running, so users on other network computers can work on 
the files you install on this computer. 

• If this computer is used for QuickBooks data entry, you can start working on files; 
and other users on the network can also work on the files on the computer because 
the database manager is running. 

 

Verifying the Database Service 
 
It’s a good idea to make sure the database service is running, and the easiest way to 
perform that task is to look for it in the Windows Task Manager. To open Task 
Manager, right-click a blank spot on the Taskbar and choose Task Manager. Move to 
the Processes tab and look for QBDBMgrN.exe. By default, the Processes tab is 
arranged alphabetically by Image Name (the name of the process), so it should be easy to 
spot QBDBMgrN.exe. If that column isn’t displayed alphabetically, click the column 
heading to rearrange the display. 
 



Installing QuickBooks 2006 on Computers That Do Not 
Hold Files 
 
You need to install QuickBooks on the computers that are used by QuickBooks data entry 
persons who are working on files on other computers on the network. Technically, we 
call the computers that hold files servers, and we call the computers without files that run 
QuickBooks clients. 
 
Configuring a client computer is not that much different from what you are used to doing 
with QuickBooks in prior years, and you only have to take these three basic steps: 
 

1. Install QuickBooks 2006 
2. Map a drive letter to the network file share (optional but customary) 
3. Open a company file on the remote computer to verify your connection to the 

database. 
 

Installing the Software 
 
Simply install QuickBooks 2006 from your software CD. If you purchased a multi-user 
product, you see the dialogs asking whether you plan to keep company files on this 
machine that will be accessed by users on other machines (which is, of course, asking 
whether you want to turn on Hosting mode). Just select the option labeled No/Not 
Sure/Will Decide Later. 
 

Mapping a Drive Letter to the Data Folder 
 
Mapping a drive means you assign a drive letter to a shared folder on another computer. 
On the computer that’s mapping the drive, some drive letters are already used, such as  
C:, D:, and perhaps even more (depending on how many hard drives, CD drives, or 
removable media drives are already attached to the computer). When you open My 
Computer, you see all the drives on the computer. When you map a drive to a shared 
folder on another computer, you see that mapped drive in the My Computer window, 
too. It also appears as a drive in the drop- down list you see at the top of any software 
Open dialog. This makes it easy to find the shared folder on another computer when you 
use the Open dialog in QuickBooks. Open My Network Places and navigate to the 
computer that holds the files you want to work on. When you double-click that 
computer’s icon or listing, all the shared resources on that computer are displayed. You 
may see multiple shared resources, because the computer may be sharing a printer or 
sharing other folders. 
 
Right-click the folder with the name that indicates it holds the QuickBooks 2006 data 
files, and choose Map Network Drive from the right-click menu to open the Map 
Network Drive dialog. By default, Windows XP selects Z: for the first mapped drive, 
and then works backwards through the alphabet as you add more mapped drives. 



Windows 2000 offers the next available drive letter (usually E: or F:, depending on the 
number of drives attached to the computer) and works forward. You can accept the 
default drive letter, or choose a different one from the drop-down list. 
 
Be sure the option Reconnect at Logon is selected, so every time you start your 
computer it links to the folder on the server represented by the mapped drive letter. 
Otherwise, you have to go through the process of mapping the drive every time you start 
your computer, or navigate through your network to reach the server and the shared 
folder every time you want to work with the QuickBooks files on that computer. 
 
In accounting firms, if you have multiple computers holding QuickBooks 2006 data files, 
repeat the process to map a drive to each of those computers that the user of this 
computer needs. You can also opt to skip the mapping of drives for additional computers 
if the work you do at this computer almost always involves data files from the shared 
folder you already mapped. Then, if you occasionally need to access a file on another 
computer that has QuickBooks 2006 data files, just click the My Network Places icon in 
the QuickBooks Open a Company dialog and navigate to the computer and its 
QuickBooks 2006 data file shared folder. 
 
 

Staying Current  
 
Intuit will continue to update its guides and White Papers at the Network/Multi-User Set 
Up page. This page is found at http://www.quickbooks.com/support/networking/.  
Start at this page for the most recent drafts of White Papers and other information on 
network installations. 
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